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Author Questionnaire 
 

1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for 
performing a complex dissection, microinjection technique, or something similar?  No    

 

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of 
software usage?  Yes, all done 

 

3. Filming location: Will the filming need to take place in multiple locations?   no 

 

 

4. Testimonials (optional): Would you be open to filming two short testimonial statements live 
during your JoVE shoot? These will not appear in your JoVE video but may be used in JoVE’s 
promotional materials. Yes    

 
 
Current Protocol Length 
Number of Steps: 17 
Number of Shots: 38  
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Introduction 
Videographer: Obtain headshots for all authors available at the filming location.  
 

INTRODUCTION: 
 
What is the scope of your research? What questions are you trying to answer?  

1.1. Rihab Bouchareb:  Our lab develops innovative methods to isolate efficient, 
dynamically active mitochondria for transplantation aimed at restoring function in 
injured organs. 

1.1.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, 
looking slightly off-camera.  

What are the current experimental challenges? 

1.2. Aasthika Das: Current challenges include tracking transplanted mitochondria without 
staining while accurately assessing their integration, functionality, and dynamic 
behavior within recipient cells. 

1.2.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, 
looking slightly off-camera.  

 

CONCLUSION: 
 
What significant findings have you established in your field? 

1.3. Vikky Awasthi: Using cells expression fluorescent photo-switchable mitochondria 
helped us track mitochondria and assess their dynamics in recipient cells. 

1.3.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, 
looking slightly off-camera.  

 

How will your findings advance research in your field? 

1.4. Sulaiman Qamar: Live-cell mitochondrial morphology measurement reveals real-time 
cell health; gene tagging and photoswitchable proteins enhance accuracy and 
measurement robustness. 

1.4.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, 
looking slightly off-camera.  

 

What questions will future research focus on? 
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1.5. Meriem Bkhache: Future research will explore cellular machineries, both 
mitochondrial and cytoplasmic, that coordinate membrane remodeling to shape 
tubular, spherical, or circular mitochondria. 

1.5.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, 
looking slightly off-camera.  

 
 

Videographer: Obtain headshots for all authors available at the filming location. 
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Testimonial Questions (OPTIONAL):  
 
Videographer: Please capture all testimonial shots in a wide-angle format with sufficient 
headspace, as the final videos will be rendered in a 1:1 aspect ratio. Testimonial statements 
will be presented live by the authors, sharing their spontaneous perspectives. 
 

 

How do you think publishing with JoVE will enhance the visibility and impact of your research? 

1.6. Dr Rihab Bouchareb, Assistant Professor, Temple University: (authors will present 
their testimonial statements live) 

Can you share a specific success story or benefit you’ve experienced—or expect to 
experience—after using or publishing with JoVE? (This could include increased collaborations, 
citations, funding opportunities, streamlined lab procedures, reduced training time, cost 
savings in the lab, or improved lab productivity.) 

1.7. Dr Rihab Bouchareb, Assistant Professor, Temple University: (authors will present 
their testimonial statements live) 
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Ethics Title Card 

This research has been approved by the Institutional Animal Care and Use Committee 
(IACUC) at Temple University 
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Protocol   
 

2. Imaging and Quantitative Analysis of Mitochondrial Fusion in Cisplatin-Treated Cells 

Demonstrator:  
 

Note: Demonstrator’s name(s) were not provided 
 

2.1. To begin, seed kidney proximal tubular cells in glass-bottom culture plates [1-TXT]. 
Incubate the cells overnight to allow for adherence and growth [2]. The next day, add 
cisplatin to the experimental plate to a final concentration of 2 micromolar [3-TXT].  

2.1.1. WIDE: Talent pipetting cell suspension into multiple wells of a glass-bottom 
culture plate. TXT: Seeding density: 1 - 5 × 105 cells/well depending on 
experimental requirements 

2.1.2. Shot of the culture plate placed inside the incubator. 

2.1.3. Talent pipetting cisplatin into the well of a culture plate inside a biosafety 
cabinet. TXT: Ensure 0.004% final concentration of DMSO 

2.2. Next, configure the lasers of a confocal microscope to 405 nanometers, 488 nanometers 
for unconverted Dendra2 excitation, and 561 nanometers [1]. Turn on the lasers and 
allow approximately 10 minutes for stabilization [2]. 
 

2.2.1. SCREEN: 69268_screenshot_000 00:00-00:09 

2.2.2. SCREEN: 69268_screenshot_000 00:10-00:24 
 

2.3. Place the culture disc in the incubation chamber [1]. Add water around the chamber 
and set the temperature to 37 degrees Celsius, ensuring the supply of carbon dioxide is 
maintained [2]. Allow the incubation chamber to equilibrate before imaging [3]. 

2.3.1. Talent carefully placing a culture disc inside the incubation chamber. 

2.3.2. Close-up of the water tray being filled and the control panel showing 37 degrees 
Celsius and CO₂ indicator. 

2.3.3. Shot of the incubation chamber closed with timer or indicator light on. 

2.4. Visualize the cells using higher magnification and resolution for mitochondrial imaging 
[1]. Open the drop-down menu in the top-left corner and select the FRAP (frapp) 
options [2]. 

2.4.1. SCREEN: 69268_screenshot_A  00:10-00:27 
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2.4.2. SCREEN: 69268_screenshot_B  00:00-00:07 
 

2.5. Using LAS X (Las-Ex) software, define the region of interest where photobleaching will 
be performed [1]. Set lasers to 405 nanometers at 0.00, 488 nanometers at 0.20, and 
561 nanometers at 0.20, and ensure the cells are in focus [2]. Then acquire a series of 
pre-bleach images at low laser intensity to establish baseline fluorescence intensity by 
[3]. 

2.5.1. SCREEN: 69628_screenshot_1 00:25-00:46 

2.5.2. SCREEN: 69628_screenshot_1 00:50-01:10  

2.5.3.  SCREEN: Pre-bleach image acquisition is being done.  
NOTE: Shot deleted by authors  

2.6. Now apply a high-intensity laser pulse to bleach the region of interest by setting FRAP 
lasers to 405 nanometers at 4.00, 488 nanometers at 0.00, and 561 nanometers at 0.00 
[1]. Set the pre-bleach to 5.140 seconds for 59 iterations and define the post-bleach 
timing [2].  

2.6.1. SCREEN: 69628_screenshot_1 01:10-01:24   

2.6.2. SCREEN: The pre-bleach settings are being defined.   
NOTE: Shot deleted by authors 

2.7. For post-bleach imaging, continue to acquire images at low laser intensity for 10 
minutes using FRAP lasers at 405 nanometers at 0.00, 488 nanometers at 0.50, and 561 
nanometers at 0.50 [1]. 

2.7.1. SCREEN: 69628_Screenshot _2 00:00-00:21  
 

2.8. To profile the merged green and red mitochondria, first install the RGB profiler plugin 
[1]. Open ImageJ software [2], then from the File menu, locate and open the image file 
to analyse [3]. 

2.8.1. SCREEN: 69268_Screenshot_3 00:00-00:16 

2.8.2. SCREEN: 69628_Screenshot _4 00:10-00:16 

2.8.3. SCREEN: 69628_Screenshot _5 00:08-00:16, 00:25-00:26 
 

2.9. Select the color mode composite, check the Auto Scale option, and open the video or 
image stack to analyze [1]. Draw a rectangular area over the image [2] and right-click to 
select Duplicate [3]. 

2.9.1. SCREEN: 69628 _Screenshot _5 00:17-00:25, 00:28-00:35 

2.9.2. SCREEN: 69628 _Screenshot _5 00:39-00:42 

2.9.3. SCREEN: 69628 _Screenshot _5 00:43-00:46 
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2.10. Select the duplicate hyper stack option to duplicate all the image stacks [1]. Select the 
image and choose RGB in the Image dropdown menu To convert the duplicated stack 
to RGB format [2]. 

2.10.1. SCREEN: 69628 _Screenshot _5 00:46-00:53 

2.10.2. SCREEN: 69628 _Screenshot _6 00:01-00:15, 00:23-00:28 
 

2.11. Duplicate the RGB image and select only one frame [1]. If the mitochondria appear 
curved, draw a line along their length [2], then go to the Edit menu, choose Selection, 
and click Straighten [3]. 

2.11.1. SCREEN: 69628_ Screenshot _7 00:00-00:12 

2.11.2. SCREEN: 69628_Screenshot _8 00:00-00:04 

2.11.3. SCREEN: 69628_Screenshot _8 00:05-00:08 
 

2.12. Now choose a title for the straightened image and set the line width to 20 pixels [1]. 
Draw a line along the straightened mitochondrion to align it properly [2] and open the 
RGB profiler plugin [3]. 

2.12.1. SCREEN: 69628_Screenshot _8 00:09-00:13 

2.12.2. SCREEN: 69628_Screenshot _8 00:14-00:25 

2.12.3. SCREEN: 69628_Screenshot _8 00:32-00:38 
 

2.13. Once activated, the plugin will generate a plot showing red and green fluorescence 
intensities along the drawn line [1]. The height of each peak will be directly proportional 
to the fluorescence intensity [2-TXT]. 

2.13.1. SCREEN: 69628_Screenshot _8 00:39-00:45 

2.13.2. SCREEN: 69628_Screenshot _8 00:46-00:51 
TXT: Verify that each florescence is localized to adjacent mitochondria 

2.14. Before mitochondrial fusion, confirm that red fluorescence is localized to one 
mitochondrion, and green fluorescence is localized to an adjacent one [1]. Verify that 
the corresponding intensity plot displays two distinct peaks with minimal overlap [2]. 

2.14.1. SCOPE/SCREEN: 69628_Screenshot _8 00:53-00:51 
 Mitochondrial pair with clearly separated red and green fluorescence are being 
seen. 
AUTHORS: Please use the cursor to show the clearly differentiated colors 

2.14.2. SCREEN: 69628_Screenshot _8 00:41-00:51 
Intensity plot showing distinct red and green peaks. 
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NOTE: Converted to on-screen text 

2.15. After fusion, confirm that the red fluorescence has spread into the adjacent green 
mitochondrion indicating content mixing [1]. Verify that the intensity plot now shows 
overlapping red and green peaks [2]. 

2.15.1. SCOPE/SCREEN: 69628_Screenshot _9 00:00-00:08 

2.15.2. SCREEN: 69628_Screenshot _9 00:09-00:19 
 

2.16. To assess fusion, select healthy mitochondria and photobleached mitochondria for 
fusion in live cell imaging [1]. Monitor the change in red to green fluorescence ratio 
over time to indicate fusion events [2]. 

2.16.1. SCOPE/SCREEN: 69628_Screenshot _10 00:10-00:26 
Field showing selection of intact and bleached mitochondria. 

2.16.2. SCREEN: 69628_Screenshot _11 00:30-00:50 
Time-series graph displaying the ratio shift of red to green fluorescence over 
time. 

 
  



 FINAL SCRIPT: APPROVED FOR FILMING 
 

© 2025, Journal of Visualized Experiments November 10, 2025 Page 11 of 13 

Results 
 

3. Results  
 

3.1. Control cells showed elongated mitochondria with yellow matrix, indicating 
mitochondrial fusion of the red and green matrices [1]. Cisplatin-treated cells exhibited 
fragmented mitochondria with reduced overlap of red and green signals, suggesting 
impaired fusion [2]. 

3.1.1. LAB MEDIA: Figure 6A. Video editor: Highlight the upper row of time-lapse 
images labeled “Control”  

3.1.2. LAB MEDIA: Figure 6A. Video editor: Highlight the lower row of time-lapse 
images labeled “Cisplatin Treated” 

3.2. Fluorescence recovery in the photobleached region declined over time in control cells, 
indicating active mitochondrial fusion [1]. Cells treated with cisplatin maintained a 
nearly stable fluorescence ratio, indicating impaired mitochondrial fusion [2]. 

3.2.1. LAB MEDIA: Figure 6B. Video editor: Highlight the downward-sloping blue line 
representing “Control”  

3.2.2. LAB MEDIA: Figure 6B. Video editor: Highlight the red line labeled “Cisplatin 
treated” 

3.3. The expression of CLRS-1 (C-L-R-S-One) was significantly reduced in cisplatin-treated 
cells compared to controls [1]. The expression of NRF1 (N-R-F-One) was significantly 
lower in cisplatin-treated cells than in controls [2]. 

3.3.1. LAB MEDIA: Figure 6C. Video editor: Highlight the first bar graph labeled “CLRS-
1” and highlight the lower red bar (cisplatin treated)  

3.3.2. LAB MEDIA: Figure 6C. Video editor: Highlight the second bar graph labeled 
“NRF1” and highlight the shorter red bar (cisplatin treated)  
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Pronunciation Guide: 
 
  Mitochondrial 
Pronunciation link: https://www.merriam-webster.com/dictionary/mitochondrial 
IPA: /ˌmaɪtəˈkɑːndriəl/ 
Phonetic Spelling: my-tuh-kon-dree-uhl 
  Fission 
Pronunciation link: https://www.merriam-webster.com/dictionary/fission 
IPA: /ˈfɪʃən/ 
Phonetic Spelling: fih-shun 
  Fusion 
Pronunciation link: https://www.merriam-webster.com/dictionary/fusion 
IPA: /ˈfjuːʒən/ 
Phonetic Spelling: fyoo-zhun 
  Proximal 
Pronunciation link: https://www.merriam-webster.com/dictionary/proximal 
IPA: /ˈprɑːksɪməl/ 
Phonetic Spelling: prok-sih-muhl 
  Tubular 
Pronunciation link: https://www.merriam-webster.com/dictionary/tubular 
IPA: /ˈtjuːbjələr/, /ˈtuːbjələr/ 
Phonetic Spelling: tyoo-byuh-ler / too-byuh-ler 
  Cisplatin 
Pronunciation link: https://www.merriam-webster.com/dictionary/cisplatin 
IPA: /ˈsɪsˌplætən/ 
Phonetic Spelling: sis-plah-tin 
  Micromolar 
Pronunciation link: https://www.howtoppronounce.com/micromolar 
IPA: /ˌmaɪkroʊˈmoʊlər/ 
Phonetic Spelling: my-kroh-moh-ler 
  Confocal 
Pronunciation link: https://www.merriam-webster.com/dictionary/confocal 
IPA: /kɑːnˈfoʊkəl/ 
Phonetic Spelling: kon-foh-kuhl 
  Nanometer 
Pronunciation link: https://www.merriam-webster.com/dictionary/nanometer 
IPA: /ˈnænəˌmiːtər/ 
Phonetic Spelling: nan-uh-mee-ter 
  Dendra2 
Pronunciation link: No confirmed link found 
IPA: /ˈdɛndrə tuː/ 
Phonetic Spelling: den-druh-too 

https://www.merriam-webster.com/dictionary/fission
https://www.merriam-webster.com/dictionary/fusion
https://www.merriam-webster.com/dictionary/proximal
https://www.merriam-webster.com/dictionary/tubular
https://www.merriam-webster.com/dictionary/cisplatin
https://www.merriam-webster.com/dictionary/confocal
https://www.merriam-webster.com/dictionary/nanometer
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  FRAP (Fluorescence Recovery After Photobleaching) 
Pronunciation link: No confirmed link found 
IPA: /fræp/ 
Phonetic Spelling: frap 
  Photobleaching 
Pronunciation link: No confirmed link found 
IPA: /ˌfoʊtoʊˈbliːtʃɪŋ/ 
Phonetic Spelling: foh-toh-blee-ching 
  Fluorescence 
Pronunciation link: https://www.merriam-webster.com/dictionary/fluorescence 
IPA: /flʊˈrɛsəns/, /flɔːˈrɛsəns/ 
Phonetic Spelling: floo-reh-sense / floor-eh-sense 
  Cytoplasmic 
Pronunciation link: https://www.merriam-webster.com/dictionary/cytoplasmic 
IPA: /ˌsaɪtoʊˈplæzmɪk/ 
Phonetic Spelling: sy-toh-plaz-mik 
 

https://www.merriam-webster.com/dictionary/fluorescence

